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BAB I 

PENDAHULUAN 

1.1 Latar Belakang 

Kesehatan merupakan hak asasi manusia dan salah satu unsur kesejahteraan 

yang harus diwujudkan. Upaya kesehatan adalah setiap kegiatan yang dilakukan secara 

terpadu, terintegrasi dan berkesinambungan untuk memelihara dan meningkatkan 

derajat kesehatan masyarakat. Bentuk upaya kesehatan seperti pencegahan penyakit, 

peningkatan kesehatan, pengobatan penyakit, dan pemulihan kesehatan. Pemerintah 

pusat dan pemerinta daerah secara berkala menetapkan jenis dan persebaran penyakit 

yang berpotensi menular atau menyebar dalam waktu yang singkat, serta menyebutkan 

daerah yang tepat menjadi sumber penularan. (Kemenkes RI, 2009) 

Hipertensi adalah suatu keadaan peningkatan tekanan darah sistolik lebih dari 

140 mmHg dan tekanan diastolik lebih dari 90 mmHg. Batas tekanan darah yang 

dianggap normal adalah kurang dari 130/85 mmHg. Bila tekanan darah sudah lebih 

dari 140/90 mmHg dinyatakan hipertensi (batas tersebut untuk orang dewasa di atas 

18tahun) (WHO, 2013). 

Menurut data WHO (2014), sekitar 972 juta orang atau 26,4% orang di dunia 

mengidap hipertensi, dan angka ini kemungkinan akan meningkat menjadi 29,2% di 

tahun 2025. Dari 972 juta pengidap hipertensi, 333 juta berada di negara maju dan 639 

sisanya berada di negara berkembang, termasuk Indonesia (Yonata dan Pratama,2016). 

Menurut Riset Kesehatan Dasar 2018, penyakit terbanyak yang terjadi pada usia lanjut 

adalah hipertensi dengan prevalensi 55,2% pada usia 55-64 tahun, 69,5% pada usia ≥ 

75 tahun dan 63,2% pada usia 65-74 tahun (Kemenkes RI, 2018).Data Riskesdas di 

Provinsi Jawa Timur, menunjukan bahwa prevalensi penyakit hipertensi mencapai 

26,2%dan tertinggi terdapat pada kelompok usia ≥ 75 tahun yaitu 62,4%. Prevalensi 

hipertensi di kota Surabaya mencapai 22 %, dimana sebanyak 16,78% terjadi di orang 

dewasa berusia 18 tahun keatas (Dinas Kesehatan Surabaya, 2015). 
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Kota Surabaya merupakan ibu kota Provinsi Jawa Timur yang memiliki 31 

kecamatan, dan 154 kelurahan. Menurut (Badan Pusat Statistik Kota Surabaya, 2020) 

jumlah penduduk Kota Surabaya pada tahun 2019 sebanyak 3.159.481 jiwa. Mengenai 

sarana kesehatan, terdapat 59 rumah sakit di seluruh kecamatan di Kota Surabaya. 

Selain itu, terdapat 63 Puskesmas , 2.776 Posyandu, dan 343 klinik.  

Puskesmas merupakan garda depan dalam penyelenggaraan upaya kesehatan 

dasar. Puskesmas Kalijudan adalah salah satu puskesmas yang terdapat di Kecamatan 

Mulyorejo. Hipertensi merupakan salah satu penyakit yang penderitanya terbanyak di 

puskesmas Kalijudan, dengan data tersebut maka akan dilakukan pemetaan sebaran 

penyakit hipertensi di Wilayah Kerja Puskesmas Kalijudan Kota Surabaya. 

Pemetaan sebaran penyakit di suatu wilayah dapat dilakukan dengan bantuan 

sistem informasi geografis dan divisualisasikan dalam bentuk peta digital. Teknologi 

pemetaan berbasis web yang dapat digunakan salah satunya adalah Google Earth. Web 

ini dapat digunakan secara gratis yang disediakan oleh Google. Kemudian, salah satu 

aplikasi sistem informasi geografis yang dapat digunakan untuk memvisualisasikan 

peta digital adalah Quantum Gis (QGIS).  

 

 

1.2 Tujuan 

 

1.2.1 Tujuan Umum 

Berdasarkan latar belakang yang telah disebutkan, tujuan dari disusunnya 

laporan magang ini ialah untuk menentukan peta ketersebaran penyakit hipertensi di 

wilayah kerja Puskesmas Kalijudan pada tahun 2020. 

 

1.2.2 Tujuan Khusus 

Adapun tujuan khusus disusunnya laporan magang ini ialah sebagai berikut: 

1. Mengetahui pemetaan ketersebaran penyakit hipertensi di wilayah kerja Puskesmas 

Kalijudan 
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2. Menentukan wilayah yang paling berisiko di wilayah kerja Puskesmas Kalijudan 

 

 

1.3 Manfaat 

 

1.3.1 Manfaat bagi mahasiswa magang 

Memberikan kesempatan bagi mahasiswa untuk mengetahui pemetaan 

ketersebaran penyakit hipertensi di wilayah kerja Puskesmas Kalijudan pada tahun 

2020.  

 

1.3.2 Manfaat bagi Fakultas Kesehatan Masyarakat 

a. Meningkatkan kualitas mahasiswa melalui magang. 

b. Terjalinnya kerjasama antara fakultas dengan instansi tempat magang. 

c. Sebagai jembatan penghubung antara dunia pendidikan dengan dunia kerja. 

d. Memperoleh informasi dan dokumentasi ilmiah tentang kondisi nyata dunia 

kerja yang dapat digunakan dalam meningkatkan kualitas lulusan mahasiswa 

jurusan Kesehatan Masyarakat. 

e. Memberikan umpan balik bagi pelaksanaan kegiatan magang selanjutnya. 

 

 

1.3.3 Manfaat bagi Instansi 

a. Laporan ini dapat dimanfaatkan sebagai acuan untuk pengembangan dan 

penerapan program yang lebih baik dan menjadi bahan evaluasi bagi institusi. 

b. Laporan ini dapat dimanfaatkan sebagai acuan untuk meningkatkan kualitas 

pembuatan peta menggunakan Quantum GIS. 

c. Puskesmas Kalijudan Kota Surabaya dapat memanfaatkan tenaga dari 

mahasiswa magang dalam membantu menyelesaikan tugas untuk kebutuhan 

pelayanan.  
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BAB II 

TINJAUAN PUSTAKA 

2.1 Sistem Informasi Geografis 

2.1.1 Definisi Sistem Informasi Geografis 

Sistem Informasi Geografis (SIG) merupakan suatu komponen yang terdiri dari 

perangkat lunak, perangkat keras, data geografis, dan sumber daya manusia yang 

bekerja bersama secara efektif untuk memasukkan, menyimpan, memperbaiki, 

memperbarui, mengelola, mengintegrasikan, menganalisis, dan menampilkan data 

dalam suatu informasi berbasis geografis. Sebagian besar data yang akan diolah pada 

SIG merupakan data spasial, yaitu sebuah data yang berorientasi geografis dan 

merupakan lokasi yang memiliki sistem koordinat tertentu sebagai dasar referensinya. 

Oleh karena itu, aplikasi SIG dapat menjawab beberapa pertanyaan mengenai lokasi, 

kondisi, kecenderungan atau tren, pola, dan simulasi atau modeling (Adil, 2017). 

Menurut John E. Harmon dan Steven J. Anderson (dalam Adil, 2017), SIG dapat 

beroperasi dengan beberapa komponen, yaitu pengguna, aplikasi, data, software, dan 

hardware. Data yang digunakan dalam SIG dapat berupa data grafis dan data atribut. 

Data grafis dapat berupa peta, foto udara, citra satelit, dan sebagainya. Sedangkan data 

atribut berupa sensus penduduk, catatan survei, dan data statistik lainnya. 

 

2.1.2 Aplikasi QGIS 

QGIS (sebelumnya dikenal sebagai Quantum GIS) adalah perangkat lunak untuk 

sistem informasi geografis (SIG) yang bersifat open source dan mampu dijalankan di 

berbagai sistem operasi yang menyediakan pernagkat untuk menampilkan, mengolah, 

dan analisis data spasial. QGIS merupakan proyek dari Open Source Geospatial 

Foundation (OSGeo), yaitu sebuah organisasi nirlaba dan nonpemerintah yang 

memiliki tujuan untuk menyatukan berbagai komunitas geo spasial. Sifatnya yang open 

source membuat perkembangan dari aplikasi QGIS ini menjadi cepat sehingga QGIS 

dapat kompatibel dengan berbagai macam sistem operasi, seperti Windows, MacOs X, 

dan juga Linux. 
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Sama seperti sistem perangkat lunak GIS lainnya, QGIS memungkinkan pengguna 

menggunakan beberapa proyeksi peta untuk membuat peta dengan banyak lapisan. Peta 

dapat disusun berdasarkan format yang berbeda dan untuk kegunaan yang berbeda. 

QGIS memungkinkan peta terdiri dari lapisan raster atau vektor. Data vektor disimpan 

sebagai rangkaian pasangan koordinat di dalam memori komputer. Data vektor 

digunakan untuk merepresentasikan titik, garis dan area. Data raster disimpan sebagai 

kisi nilai. Ada berbagai satelit yang mengelilingi bumi dan foto-foto yang diambil 

adalah sejenis data raster yang dapat dilihat di sistem informasi geografis (SIG). Satu 

perbedaan antara data raster dan vektor adalah jika gambar raster diperbesar terlalu 

banyak, gambar tersebut akan mulai tampak kuning (QGIS, 2020). 

 

2.2 Hipertensi 

2.2.1 Definisi Hipertensi  

Hipertensi atau yang biasa disebut tekanan darah tinggi merupakan peningkatan 

tekanan darah sistolik di atas batas normal yaitu lebih dari 140 mmHg dan tekanan 

darah diastolik lebih dari 90 mmHg (WHO, 2013). Penyakit hipertensi atau tekanan 

darah tinggi adalah salah satu jenis penyakit yang mematikan di dunia dan faktor risiko 

paling utama terjadinya hipertensi yaitu faktor usia sehingga tidak heran penyakit 

hipertensi sering dijumpai pada usia senja/usia lanjut (Fauzi, 2014), sedangkan menurut 

(Setiati, 2015), hipertensi merupakan tanda klinis ketidakseimbangan hemodinamik 

suatu sistem kardiovaskular, di mana penyebab terjadinya disebabkan oleh beberapa 

faktor / multi faktor sehingga tidak bisa terdiagnosis dengan hanyasatu faktor tunggal. 

Hipertensi adalah kenaikan tekanan darah tinggi melebihi normal, dengan normal 

tekanan darah sistolik 140 mmHg dan diastolik 90 mmHg. Dengan kategori hipertensi 

Normal (<120 mmHg), Pra-hipertensi (120-139 mmHg), Hipertensi Tingkat 1 (140-

159 mmHg), Hipertensi tingkat 2 (>160 mmHg). 

 

2.2.2 Faktor Risiko Hipertensi 

Faktor-Faktor Risiko Hipertensi Menurut (Rizki, 2017) 

faktor risiko hipertensi dibagi menjadi 2 kelompok, yaitu :  
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1. Faktor yang tidak dapat diubah Faktor yang tidak dapat berubaha adalah :  

a. Riwayat Keluarga 

Seseorang yang memiliki keluarga seperti, ayah, ibu, kakak kandung/saudara 

kandung, kakek dan nenek dengan hipertensi lebih berisiko untuk terkena 

hipertensi. 

b. Usia 

Tekanan darah cenderung meningkat dengan bertambahnya usia. Pada laki-laki 

meningkat pada usia lebih dari 45 tahun sedangkan pada wanita meningkat pada 

usia lebih dari 55 tahun.  

c. Jenis Kelamin 

Dewasa ini hipertensi banyak ditemukan pada pria daripada wanita.  

d. Ras/etnik 

e. Hipertensi menyerang segala ras dan etnik namun di luar negeri hipertensi 

banyak ditemukan pada ras Afrika Amerika daripada Kaukasia atau Amerika 

Hispanik. 

 

 

2. Faktor yang dapat diubah 

Kebiasaan gaya hidup tidak sehat dapat meningkatkan hipertensi antara lain yaitu: 

a. Merokok 

Merokok merupakan salah satu faktor penyebab hipertensi karena dalam rokok 

terdapat kandungan nikotin. Nikotin terserap oleh pembuluh darah kecil dalam 

paru-paru dan diedarkan ke otak. Di dalam otak, nikotin memberikan sinyal 

pada kelenjar adrenal untuk melepas epinefrin atau adrenalin yang akan 

menyemptkan pembuluh darah dan memaksa jantung bekerja lebih berat karena 

tekanan darah yang lebih tinggi (Yudhisti, 2013) 

b. Kurang aktifitas fisik 

Aktifitas fisik adalah setiap gerakan tubuh yang dihasilkan oleh otot rangka 

yang memerlukan pengeluaran energi. Kurangnya aktifitas fisik merupakan 
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faktor risiko independen untuk penyakit kronis dan secara keseluruhan 

diperkirakan dapat menyebabkan kematian secara global (Iswahyuni, 2017) 

c. Konsumsi Alkohol Alkohol memiliki efek yang hampir sama dengan karbon 

monoksida, yaitu dapat meningkatkan keasaman darah. Darah menjadi lebih 

kental dan jantung dipaksa memompa. darah lebih kuat lagi agar darah sampai 

ke jaringan mencukupi (Komaling, Suba and Wongkar, 2013) .Maka dapat 

disimpulkan bahwa konsumsi alkohol dapat meningkatkan tekanan darah. 

d. Kebiasaan minum kopi Kopi seringkali dikaitkan dengan penyakit jantung 

koroner, termasuk peningkatan tekanan darah dan kadar kolesterol darah karena 

kopi mempunyai kandungan polifenol, kalium, dan kafein. Salah satu zat yang 

dikatakan meningkatkan tekanan darah adalah kafein. Kafein didalam tubuh 

manusia bekerja dengan cara memicu produksi hormon adrenalin yang berasal 

dari reseptor adinosa didalam sel saraf yang mengakibatkan peningkatan 

tekanan darah, pengaruh dari konsumsi kafein dapat dirasakan dalam 5-30 

menit dan bertahan hingga 12 jam (Bistara and Kartini, 2018) 

e. Kebiasaan konsumsi makanan banyak mengandung garam Garam merupakan 

bumbu dapur yang biasa digunakan untuk memasak. Konsumsi garam secara 

berlebih dapat meningkatkan tekanan darah. Menurut Sarlina, Palimbong, S., 

Kurniasari, M.D., Kiha, R.R. (2018), natrium merupakan kation utama dalam 

cairan ekstraseluler tubuh yang berfungsi menjaga keseimbangan cairan. 

Natrium yang berlebih dapat mengganggu keseimbangan cairan tubuh sehingga 

menyebabkan edema atau asites, dan hipertensi. 

f. Kebiasaan konsumsi makanan lemak Menurut Jauhari dalam (Manawan, Rattu 

and Punuh, 2016), lemak didalam makanan atau hidangan memberikan 

kecenderungan meningkatkan kholesterol darah, terutama lemak hewani yang 

mengandung lemak jenuh. Kolesterol yang tinggi bertalian dengan peningkatan 

prevalensi penyakit hipertensi. 
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BAB III 

METODE KEGIATAN MAGANG 

 

3.1 Lokasi Magang 

Pelaksanaan kegiatan magang berlokasi di: 

Puskesmas Kalijudan Kota Surabaya 

Jl. Kalijudan 123 Surabaya, Kecamatan Mulyorejo, Kota Surabaya – Jawa Timur 

60114  

Telepon : 031 3824566 

Email  : pkmkalijudan@gmail.com 

3.2 Waktu Pelaksanaan Magang 

Pelaksanaan kegiatan magang berlangsung pada tanggal 18 Januari 2021 – 26 

Februari 2021 dengan rincian jadwal kegiatan magang yang dilaksanakan sebagai 

berikut: 

Tabel 3.1 Jadwal Kegiatan Magang 

No Kegiatan 

Waktu 

Januari Februari 

III IV I II III IV 

1. Pelaksanaan Magang 

a) Perkenalan dan Orientasi 

tempat magang secara online 

b) Mempelajari struktur 

organisasi 

c) Melakukan pengumpulan data 

untuk laporan magang 

      

 d) Presentasi laporan mingguan 

melalui zoom meeting 
      

2. Supervisi Dosen Pembimbing       

3. Penentuan Tema Laporan 

Magang 
      

4. Penyusunan Laporan Magang       

5. Seminar Laporan Magang       
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3.3 Metode Pelaksanaan Magang 

Proses kegiatan magang dilaksanakan secara online dengan menggunakan 

beberapa model, yaitu: 

a. Diskusi 

Model diskusi dilakukan untuk mendapatkan informasi profil Puskesmas Kalijudan 

mengenai struktur organisasi, upaya program kesehatan, dan kasus penyakit di 

Puskesmas Kalijudan. Selain itu, diskusi juga dilakukan untuk mendapatkan 

informasi lebih mendalam mengenai data yang ada di profil Puskesmas Kalijudan 

yaitu beberapa penyakit yang ada di wilayah kerja Puskesmas Kalijudan.   

b. Partisipasi aktif 

Model partisipasi umumnya berhubungan dengan kegiatan praktik sebagai upaya 

untuk belajar dan bekerja secara aktif dalam melatih keterampilan dan kemampuan 

dalam bekerja secara mandiri maupun dalam tim. Kegiatan praktik yang dilakukan 

yaitu mempelajari data sekunder, memetakan sebaran penyakit dan melakukan 

presentasi laporan mingguan. Sehubungan dengan pelaksanaan magang yang 

dilaksanakan secara daring, maka kegiatan praktik dilaksanakan secara online di 

rumah masing-masing.  

3.4 Teknik Pengumpulan Data 

Teknik pengumpulan data dalam laporan ini menggunakan data sekunder yang 

diperoleh dari Puskesmas Kalijudan. Data yang diambil berupa Profil Puskesmas 

Kalijudan dan data kasus hipertensi di wilayah kerja Puskesmas Kalijudan pada tahun 

2020. Data kasus hipertensi tersebut berupa rekam medis pasien yang berisi alamat 

rumah dan tanggal pasien melakukan kunjungan ke Puskesmas Kalijudan. Selanjutnya, 

pencarian titik koordinat tiap alamat pasien melalui online menggunakan software 

Google Earth Pro. 

3.5 Output Magang 

Hasil dari kegiatan magang ini yaitu berupa penulisan laporan magang yang 

dilakukan mahasiswa sesuai topik laporan yang diangkat yaitu peta ketersebaran 

penyakit hipertensi di wilayah kerja Puskesmas Kalijudan tahun 2020. Penulisan 
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laporan ini juga dilakukan sebagai bahan monitoring dan evaluasi serta sebagai hasil 

pelaksanaan kegiatan magang yang dilakukan selama 6 minggu. 
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BAB IV 

HASIL DAN PEMBAHASAN 

4.1 Gambaran Umum Institusi Magang 

4.1.1 Visi dan Misi Puskesmas Kalijudan 

Visi Puskesmas Kalijudan yaitu:  

“Terwujudnya Masyarakat Yang Sehat dengan Memberikan Pelayanan 

Profesional”. 

Dalam rangka mencapai visi tersebut, maka ditetapkan misi Puskesmas Kalijudan 

yaitu sebagai berikut: 

1. Meningkatkan kualitas Sumber Daya Manusia 

2. Memberikan Pelayanan Kesehatan yang berkualitas 

3. Memelihara dan meningkatkan mutu kegiatan UKP, UKM serta kerja sama lintas 

sektor 

Janji layanan Puskesmas Kalijudan yaitu: 

1. Memberikan pelayanan sesuai Standart Pelayanan dan kewajiban 

2. Melakukan perbaikan pelayanan secara berkesinambungan 

3. Sanggup menerima sanksi atau memberikan kompensasi apabila pelayanan yang 

diberikan tidak sesuai standart pelayanan 

4.1.2 Pelayanan Puskesmas 

Pelayanan Puskesmas Kalijudan terdiri atas Puskesmas Induk dan Puskesmas 

Pembantu Dukuh Sutorejo dengan jadwal pelayanan dari hari Senin hingga hari Sabtu. 

Berikut ini adalah beberapa kegiatan yang dilaksanakan oleh Puskesmas Induk dan 

Puskesmas Pembantu Dukuh Sutorejo, yaitu: 

a. Melaksanakan pelayanan kesehatan kepada masyakarat melalui pelayanan 

kesehatan ibu dan anak, keluarga berencana, perbaikan gizi, imunisasi dan 

pengobatan sederhana. 

b. Melaksanakan penyuluhan dan pembinaan peran serta masyarakat dalam wilayah 

kerja tertentu yang ditetapkan Kepala UPTD. 

c. Melaksanakan tugas-tugas lain yang diberikan oleh Kepala UPTD sesuai dengan 

tugas dan fungsinya. 
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4.1.3 Upaya Pelayanan Kesehatan 

Terdapat dua upaya pelayanan kesehatan puskesmas, yaitu pelayanan Upaya 

Kesehatan Perorangan (UKP) dan Upaya Kesehatan Masyarakat (UKM). 

Penyelenggaraan UKP tingkat pertama di wilayah kerja Puskesmas Kalijudan, yaitu: 

a. Menyelenggarakan pelayanan kesehatan dasar secara komprehensif, 

berkesinambungan dan bermutu 

b. Menyelenggarakan pelayanan kesehatan yang mengutamakan upaya promotif dan 

preventif 

c. Menyelenggarakan pelayanan kesehatan yang berorientasi pada individu, keluarga, 

kelompok dan masyarakat 

d. Menyelenggarakan pelayanan kesehatan yang mengutamakan keamanan dan 

keselamatan pasien, petugas dan pengunjung. 

e. Menyelenggarakan pelayanan kesehatan dengan prinsip koordinatif dan kerjasama 

inter dan antar profesi 

f. Melaksanakan rekam medis 

g. Melaksanakan pencatatan, pelaporan, dan evaluasi terhadap mutu dan akses 

pelayanan kesehatan 

h. Melaksanakan peningkatan kompetensi Tenaga Kesehatan 

i. Mengkoordinasikan dan melaksanakan pembinaan fasilitas pelayanan kesehatan 

tingkat pertama di wilayah kerjanya 

j. Melaksanakan penapisan rujukan sesuai dengan indikasi medis dan sistem rujukan 

Sedangkan penyelenggaraan UKM tingkat pertama di wilayah kerja Puskesmas 

Kalijudan, yaitu : 

a. Melaksanakan perencanaan berdasarkan analisis masalah kesehatan masyarakat dan 

analisis kebutuhan pelayanan yang diperlukan. 

b. Melaksanakan advokasi dan sosialissi kebijakan kesehatan. 

c. Melaksankan komunikasi, informasi, edukasi, dan pemberdayaan masyarakat dalam 

bidang kesehatan. 
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d. Menggerakkan masyarakat untuk menidentifikasi dan menyelesaikan masalah 

kesehatan pada setiap tingkat perkembangan masyarakat yang bekerjasama dengan 

sector lain terkait. 

e. Melaksanakan pembinaan teknis terhadap jaringan pelayanan dan upaya kesehatan 

berbasis masyarakat. 

f. Melaksanakan peningkatan ompetensi sumber daya manusia Puskesmas. 

g. Memantau pelaksanaan pembangunan agar berwawasan kesehatan 

h. Melaksanakan pencatatan, pelaporan, dan evaluasi terhadap akses, mutu, dan 

cakupan pelayanan kesehatan. 

i. Memberikan rekomendasi terkait masalah kesehatan masyarakat, termasuk 

dukungan terhadap sistem kewaspadaan dini dan respon penanggulangan penyakit. 

Puskesmas Kalijudan menyelenggarakan upaya kesehatan program pokok dan 

pengembangan. Upaya kesehatan program pokok meliputi: upaya promosi kesehatan, 

upaya kesehatan lingkungan, upaya perbaikan gizi,upaya kesehatan ibu dan anak 

termasuk keluarga berencana, upaya pencegahan dan pemberantasan penyakit menular, 

dan pengobatan. Sedangkan upaya kesehatan program pengembangan meliputi: upaya 

kesehatan usia lanjut, upaya kesehatan mata atau pencegahan kebutaan, upaya 

kesehatan telinga atau pencegahan gangguan pendengaran, kesehatan jiwa, pencegahan 

dan penanggulangan penyakit gigi, perawatan kesehatan masyarakat, bina kesehatan 

tradisional, bina kesehatan kerja, pemberdayaan masyarakat dalam perilaku hidup 

bersih dan sehat (PHBS), pengembangan upaya kesehatan bersumberdaya masyarakat 

(UKBM), dan yang terakhir adalah program gizi. 

4.1.4 Upaya Pencegahan dan Pemberantasan Penyakit Menular 

Beberapa jenis kegiatan yang termasuk dalam upaya pencegahan dan 

pemberantasan penyakit menular Puskesmas Kalijudan, yaitu: 

a. Diare 

Kegiatannya meliputi: penemuan penderita diare yang diobati di puskesmas dan 

kader, cakupan pelayanan diare, angka penggunaan oralit, angka penggunaan 

Ringer Lactat, proporsi penderita diare balita yang diberi tablet Zinc dan Case 

Fatality Rate (CFR) KLB Diare. 
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b. ISPA 

Kegiatannya meliputi: cakupan penemuan penderita Pneumonia balita. 

c. Kusta 

Kegiatannya meliputi: penemuan penderita kusta baru (case detection rate), 

proporsi kasus kusta anak, proporsi kasus kusta tingkat II, prevalensi kusta 

(prevalensi rate), Release From Treatmen atau angka kesembuhan penderita Pause 

Basiler dan Release From Treatment atau angka kesembuhan penderita Multi 

Basiler. 

d. Tuberkolosis Paru 

Kegiatannya meliputi: penemuan suspect penderita tuberkolosis, proporsi pasien 

tuberkolosis paru Bakteri Tahan Asam positif diantara suspek tuberkolosis, angka 

keberhasilan pengobatan pasien baru Bakteri Tahan Asam positif dan angka 

kesalahan laboratorium (Puskesmas Pelaksana Mandiri dan Puskesmas Rujukan 

Mikrobiologi). 

e. Pencegahan dan Penanggulangan Penyakit Menular Seksual dan Human 

Immunodeficiency Virus /Acquired Immunodeficiency Syndrome 

Kegiatannya meliputi: jumlah kegiatan penyuluhan di Puskesmas dan kelompok 

sasaran yang dijangkau. 

f. Demam Berdarah Dengue 

Kegiatannya meliputi: jumlah rumah yang dilakukan pemeriksaan jentik berkala, 

penderita demam berdarah dengue ditangani, Case Fatality Rate Kasus penyakit 

demam berdarah dengue, angka bebas jentik dan jumlah wilayah KLB demam 

berdarah dengue. 

g. Pencegahan dan Penanggulangan Rabies 

Kegiatannya meliputi: cuci luka terhadap kasus gigitan hewan perantara rabies dan 

vaksinasi terhadap kasus gigitan hewan perantara rabies yang berindikasi. 

h. Pelayanan Imunisasi 

Pelayanan Imunisasi meliputi: Imunisasi HB 0-7 hari pada bayi, BCG pada bayi, 

DPT/HB 1 pada bayi, DPT/HB 3 pada bayi, Campak pada bayi, drop out DPT/HB 
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1-Campak, drop out DPT/HB1-DPT/HB 3, Desa/Kelurahan Universal Child 

Immunization (UCI). 

 

i. Pengamatan Penyakit (Surveillans Epidemiologi) 

Kegiatannya meliputi: laporan Surveilans Terpadu Penyakit (STP) yang tepat 

waktu, kelengkapan laporan STP, laporan C1 (campak) yang tepat waktu, laporan 

W2 (mingguan) yang tepat waktu, kelengkapan laporan W2 (mingguan), grafik 

penyakit potensial wabah, laporan Kejadian Ikutan Pasca Imunisasi (KIPI) Zero 

reporting dan Desa/Kelurahan yang mengalami KLB ditanggulangi < 24 jam. 
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4.1.5 Struktur Organisasi 

 

Gambar 4.1 Struktur Organisasi Puskesmas Kalijudan
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4.2 Kependudukan 

Berdasarkan Profil Puskesmas Kalijudan tahun 2020, Puskesmas Kalijudan 

memiliki wilayah kerja 3 kelurahan, yaitu yaitu Kelurahan Kalijudan, Kelurahan 

Dukuh Sutorejo, dan Kelurahan Kalisari dengan total luas wilayah 559,397 Ha dan 

jumlah penduduk sebanyak 43.276 jiwa. 

Tabel 4.1 Distribusi Penduduk Berdasarkan Kelurahan 

Kelurahan 
Luas Wilayah 

(Ha) 

Jumlah 

Penduduk (Jiwa) 

Kepadatan 

Penduduk 

(Jiwa/km2) 

Kalijudan 131,351 13.067 9.948,15 

Dukuh Sutorejo 214,716 15.558 7.245,85 

Kalisari 213,330 14.651 6.867,76 

Berdasarkan tabel tersebut dapat dilihat bahwa, wilayah kelurahan yang paling 

luas yaitu Kelurahan Sukuh Sutorejo, sedangkan kelurahan dengan kepadatan 

penduduk paling tinggi yaitu Kelurahan Kalijudan yaitu sebesar 9.948,15 jiwa/km2. 

 

4.3 Langkah Pembuatan Peta 

Langkah – langkah pembuatan peta berdasarkan data sekunder yang diperoleh ialah 

sebagai berikut : 

1. Pengolahan data sekunder kasus penyakit hipertensi 

Data sekunder berupa rekam medis pasien yang berkunjung ke Puskesmas 

Kalijudan diolah terlebih dahulu karena terdapat pasien di luar wilayah kerja 

puskesmas. Data awal sejumlah 1011, setelah dilakukan pembersihan diperoleh data 

585 pasien hipertensi di wilayah kerja Puskesmas Kalijudan. Data yang diperoleh 

hanya berisi alamat pasien, sehingga perlu dilakukan pencarian titik koordinat alamat 

setiap pasien tersebut. 

2. Pencarian titik koordinat pasien menggunakan aplikasi Google Earth 

Google earth merupakan salah satu software yang dapat digunakan untuk mencari 

titik koordinat sebuah lokasi. Pencarian titik koordinat dilakukan dengan menuliskan 

alamat sesuai dengan data, lalu akan muncul nilai titik koordinat x dan y. 
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Gambar 4.2 Pencarian titik koordinat menggunakan Google Earth 

3. Input titik koordinat ke dalam format csv 

Masukkan titik koordinat yang sudah diperoleh ke microsoft excel  dan simpan 

dalam format csv. 

 

Gambar 4.3 Format titik koordinat dalam bentuk csv 
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4. Input file peta wilayah kerja Puskesmas Kalijudan format shp ke QGIS  

Langkah selanjutnya yaitu menggunakan software QGIS untuk membuat peta. 

Membuka peta project wilayah kerja Puskesmas Kalijudan dalam format shp. Cara 

memasukkan peta project yaitu pilih menu Layer > Data Source Manager > Add 

Vector Layer > pilih data peta project pada kolom Vector Dataset(s) lalu klik 

“Add”. 

 

Gambar 4.4 Input peta project ke QGIS 
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Gambar 4.5 Hasil input peta project 

Kemudian, jika ingin megubah warna dasar peta dengan cara berikut klik kanan 

pada Layer Peta > Properties > Symbology > Single symbol > pilih warna yang 

diinginkan. 

5. Input file titik koordinat format csv ke QGIS  

Langkah selanjutnya untuk memasukkan titik koordinat kasus Hipertensi, lokasi 

kantor kelurahan, lokasi fasilitas kesehatan lain, dan lokasi Polsek yaitu dengan pilih 

menu Layer > Data Source Manager > Add Delimited Text Layer > pilih data titik 

koordinat yang akan digunakan pada kolom File Name lalu klik “Add”. 
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Gambar 4.6 Input koordinat ke QGIS 

Lakukan langkah yang sama untuk memasukkan titik koordinat fasilitas kesehatan, 

kantor kelurahan, dan polsek di wilayah kerja Puskesmas Kalijudan. Memberi label 

nama untuk titik koordinat fasilitas kesehatan, kantor kelurahan, dan polsek dengan 

cara klik Properties > Labels > Single labels > Apply. 

6. Pembuatan Project Peta  

Membuat projek peta dengan memilih menu Project > New Print Layout > Beri 

nama file projek > Enter. Selanjutnya tambahkan peta serta atribut peta seperti judul 

peta, arah mata angin, legenda, dan skala pada menu Add Item. 

Kemudian, file project yang sudah selesai dikerjakan, disimpan dan diexport menjadi 

gambar dengan format png.
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Gambar 4.7 Hasil print layout peta
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Berdasarkan hasil peta di atas, dapat diketahui jumlah kasus hipertensi sesuai 

dengan wilayah kelurahannya sebagai berikut : 

Tabel 4.2 Jumlah kasus Hipertensi tiap kelurahan 

No Kelurahan Jumlah Kasus 

1. Kalijudan 420 

2. Kalisari 57 

3. Dukuh Sutorejo 108 

 

Kasus Hipertensi paling banyak terjadi di wilayah kerja Puskesmas Kalijudan pada 

tahun 2020 yaitu di kelurahan Kalijudan sebesar 420 kasus. Kelurahan Kalijudan 

memiliki tempat layanan publik paling banyak diantara dua kelurahan lain. Layanan 

publik tersebut yaitu Rumah Sakit Ibu dan Anak Kendangsari, Rumah Sakit Mitra 

Keluarga, Kantor Kelurahan Kalijudan, dan Puskesmas Kalijudan itu sendiri. 

Banyaknya hasil pemeriksaan pasien yang bertempat tinggal di Kelurahan Kalijudan 

karena letaknya yang dekat dengan Puskesmas Kalijudan. Sedangkan pasien di 

kelurahan Kalisari dan Dukuh Sutorejo kemungkinan memilih puskesmas lain yang 

jaraknya lebih dekat dengan tempat tinggal mereka. Berdasarkan hasil peta yang sudah 

dibuat juga terlihat bahwa di wilayah kelurahan Kalisari bagian barat tidak terdapat 

pasien yang berkunjung ke Puskesmas Kalijudan, hal ini dikarenakan mereka lebih 

memilih puskesmas lain yang jaraknya lebih dekat dengan rumah mereka. 
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BAB V 

PENUTUP 

5.1 Kesimpulan 

Berdasarkan analisis dan pembahasan yang telah dilakukan, diperoleh kesimpulan 

yaitu kasus hipertensi paling banyak terjadi di Kelurahan Kalijudan yaitu sebanyak 420 

kasus dan yang terendah yaitu Kelurahan Kalisari sebanyak 57 kasus. Terdapat 4 

fasilitas kesehatan yang terdapat di wilayah kerja Puskesmas Kalijudan, 3 fasilitas 

kesehatan terletak di Kelurahan Kalijudan dan 1 fasilitas kesehatan terletak di 

Kelurahan Dukuh Sutorejo. Ketersebaran fasilitas kesehatan yang kurang merata 

menyebabkan semakin dekat jarak tempat tinggal ke fasilitas kesehatan, maka semakin 

banyak pasien yang berobat ke fasilitas kesehatan tersebut sehingga kasus yang tercatat 

makin banyak. 

 

5.2 Saran 

Saran yang dapat diberikan dari hasil penyusunan laporan ini yaitu data pasien 

hipertensi masih banyak yang berasal dari luar wilayah kerja Puskesmas Kalijudan dan 

terdapat penulisan alamat yang kurang lengkap, sehingga proses untuk menganalisis 

data kurang maksimal. Oleh karena itu, pencatatan dan pelaporan perlu ditingkatkan 

lagi.
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LAMPIRAN 

Foto Kegiatan 
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Catatan Kegiatan dan Absensi Magang 

Nama Mahasiswa : Risyad Rosyadi 

NIM   : 101711133187  

Tempat Magang : Puskesmas Kalijudan 

Minggu Kegiatan 

Menyetujui 

Pembimbing 

Instansi 

Pembimbing 

Departemen 

I 

Tanggal: 18 Januari 2021 

 
 

Perkenalan dan orientasi dengan 

pihak Puskesmas Kalijudan, 

kemudian mempelajari Profil 

Puskesmas Kalijudan. 

II 

Tanggal: 27 Januari 2021 

 
 

Melakukan diskusi mengenai Unit 

Sistem Informasi dan Administrasi 

Kesehatan serta menentukan topik 

kasus yang akan digunakan. 

III 

Tanggal: 4 Februari 2021 

 
 

Presentasi hasil analisis pemetaan 

sebaran kasus Hipertensi dan Diare di 

wilayah kerja Puskesmas Kalijudan 

tahun 2020, melalui aplikasi zoom 

yang dihadiri oleh pembimbing 

departemen dan pembimbing dari 

Puskesmas Kalijudan. 

IV 

Tanggal: 10 Februari 2021 

 
 

Presentasi hasil analisis pemetaan 

sebaran kasus Diabetes Mellitus dan 

ISPA di wilayah kerja Puskesmas 

Kalijudan tahun 2020, melalui 

aplikasi zoom yang dihadiri oleh 

pembimbing departemen dan 

pembimbing dari Puskesmas 

Kalijudan. 
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V 

Tanggal: 18 Februari 2021 

 
 

Presentasi hasil analisis pemetaan 

sebaran kasus Covid-19 di wilayah 

kerja Puskesmas Kalijudan pada 

bulan Januari-Februari 2021, melalui 

aplikasi zoom yang dihadiri oleh 

pembimbing departemen dan 

pembimbing dari Puskesmas 

Kalijudan. 

VI 

Tanggal: 26 Februari 2021 

 
 

Pelaksanaan seminar hasil kegiatan 

magang melalui aplikasi zoom yang 

dihadiri oleh pembimbing 

departemen dan pembimbing dari 

Puskesmas Kalijudan. 
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Absensi Mahasiswa 

ABSENSI MAGANG 

FAKULTAS KESEHATAN MASYARAKAT UNIVERSITAS AIRLANGGA 

Nama 

Mahasiswa 

Minggu 

I II III IV V VI 

Ajeng 

Hikmatun 

Nazillah       

Benitta 

Biyantari 

Eka Putri 

Utomo 
      

Nadea 

Alda 

Nariswari 
      

Risyad 

Rosyadi       

Achmad 

Risyaf 

Alfalakh       
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Surat Pengantar Magang 
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Surat Balasan dari Instansi tempat Magang 
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